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M) Pointer Materi

Page setup (termasuk mirror margin)
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Pemberian nomor halaman
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BSN) Simulasi SNI

1) Atur terlebih Page Setup dengan ketentuan atas
Batas kiri: 3 cm o
Batas atas: 3 cm
Batas kanan: 2 cm
Batas bawah: 2 cm

Kiri kanan

2) Font arial dengan ketentuan bold
Judul SNI 18 pt
No SNI pada cover : 14 pt
No. SNI pada substansi : 11 pt
No, halaman SNI : 10 pt

Daftar isi, prakata, lampiran : 12 pt bawah
Untuk substansi SNI : 11 pt (tidak bold kecuali

untuk penomeran dan nama pasal dan sub pasal

judul tabel/gambar)

15 Twﬁaamm‘amwmﬁmﬁm

Untuk Word
langsung (‘ive") serngkall idak dapat dilakukan karena vanabiitas bawaan sumber bau tak

sedap. Suatu sumber bau tak sedap yang sebenamya dapat digunakan jica memungiankan 20070
Akan teiapi penggunaan sualu fomuia sumber bau tk sedap memilid beberapa
keuntungan termasuk konsstensi dan ketersediaannya.

16 Produk pengharum nuangan djual secara komersidl dengan maksud uniuk menad
sugly sarana memperbaki kuaitas bau sualy volume udara, relal terhadap beberapa °

kondsi ingkungan yang ada Hal i secara khusus melibatian pemakaian sualy senyawa Kllk que
berbau pada sutu ruang udara melall beberapa mekansme mekank dau fisk Bia

Ingiungan yang ada mengandung beberapa sumber bau yang tak dikehendai, aau bau

semmmsrmrmesr== | Layout » Page

pengurangan bau yang lan
17 Tuuan dan cara i adaizh uniuk memerks kemampuan produk penghanm niangan seiup
mmmmmmmmgmmmmkm

pembandng. Beberapa hipotess 5
pegp\Tqmmgrummmmmm
|
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kemudian:

Margin (untuk pengaturan batas tepi halaman)
Pager—)A4, :\.,yd VUGS BB e Q@
Layout > Header:1.5cm ..° = " T ¢ T . rerery

Footer: 1.3 cm =i o erm P2 wo e 1 B0
Selanjutnya klik OK. — T

et s e e b BERSAE Oom
- Pegebatground

Rz

RSNMASTME 15| [ o
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Komite Akreditasi Nasional

Page Setup Word 2003

Page Setup ) : 7 >€'

Page Setup na Margins | Paper  Layout |

Section

Margins | Paper I Layout I Section start: msw page -

S [¥ Suppress sndnotes
Top: B = gottom: [2 em =

Inside: 3 cm E‘ Qutside: |2 cm E‘

Gutter: 0cm E‘ Gutter position: [Left -

Headers and footers

v Different odd and even
Orientation ¥ i
T From edae: Header: |1.5 cm E‘
Footer: |1.3em 5‘
Porkrait Landscape:
Page
Pages
Multiple pages: Mirror margins Wertical alignment: Top -
Freview
Preview
Apply ta:
Apply to! —_— —_— i

Whole documert: - _ - whole document j

Line Mumbers... | Borders... |

Default...

Defaul

Carcel
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BSN)
Page Number (Nomor halaman)

+ Cover tidak diberi nomor halaman

+ Daftar isi, Prakata, Pendahuluan (“iiiiii"” dst)

+ Untuk substansi standar (penulisan dengan angka
halaman ke "... dari...”"banyak halaman)

+ Klik View > Header and Footer = Insert Auto Text 2>
Page X of Y

» Edit Page X of Y menjadi “X dari Y”

Header and Footer

Insert AutoText ~ = M By E;‘? & T O, | Cose

|
Same a previous harus dalam kondisi seperti ini (tidak aktif) supaya tidak
berulang di halaman sebelumnya

B&) Pembuatan nomor halaman
(Word 2007)

hpapd  ddees  Weing  dmer  Vew

Pilih Insert = Footer
- edit Footer

15 Teah diendl behwa welz

tengmrg (ve') seingial ik d

sedzp Suay smberbastk sed —

Mo E2p. penggnazn SR G i rmamiey.
fartngn Tk cesses

15 Prodk penghaum nangan Gl secara komersal dengan maksud wik menadi
Suay sa@na menpertall it bey sualy vome uiaa el Efakp bebeme
ors Ingengen vang 262 3l m secars iuss melbasian pemaaan S A
berbau pada suat niang wiare melhs beberaps mekansme mekank 2au sk B
inglungan vang 3tz mengandung beberapa sumber bau vang o3k dkehenda. 33y baU
1k seiap. penguangan perseps beu ik sedp by G dengan sevawa bt
¥ag lan medls masony Presedy m pge dxpd diepian wink mensme
pengusangan bau yang an.

17 Tigan dan carz i adih unk memesis kemampuan podk pesghanm nangn
ik menguEg Tiesis ta X s ulm nag BMAD G e londs
pembandng Beberpa hpoiess ckpeTmena memunginkan bematng 4 hEn
penguian Tupan yang mungin besez masng-masng hpoiesswe dberian paia
Lamprn X0
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j% “ Q _,} =H DrateaTine

Shapes St (ot Hyperink Bsokmark Cos-eioence | Hester
= = g one -

. .57 . ik Edit Footer >

A= Bsgenreine

] E— ~ Page Number -
f— current position 2>
L Page X of Y
m:_ _ Kemudian edit
- Page X of Y menjadi
Pemeriksaan efik: XdariY
dalam mengurang I

FlE T p—

.

3 bemesan e

M) Page Break/memisah-
kan bagian halaman

(klik Insert > Break > Next Page)

Khusus untuk Word 2007:
Pilih Insert > Page Break

Prakata

Dalam rangka memberikan jaminan mutu dan keamanan pangan tethadap komoditas yang
akan dipasarkan di dalam dan luar neger, maka peru disusun suatu Standard Masiona:
ndonesia (SNI) tentang Metode Uji vang dapat memenuhi jaminan tersebut

Standard ini
melalui rapat RS

==% Perikanan yang telah diumuskar
[Z|. di Bogor dan dihadiri oleh anggots

panitia tekni si, lembaga penelitian, pergumiar:

inggi dan ing Break types ptkan jaminan mutu dan keamanari

pangan. () Page brezk

Serkaitan del O Column brezk sional Indonesia ini, maka aturan:

aturan yang of () Text wrapping break
Undang- Section break types -

D Undang] (extpage:

3 Peraturar) (O Continuous bel dan Iklan Pangan.

4 Keputusa N EP. 01MEN/2002 tentang Siste;
Manzjem| © Evenpage

5 Keputusal (O Oddpage Mo, KEP. OBMEN/2002 tentanc
Persyarat Perikanan yang Mauk ke Wilayal:
Republik

5 Keputus: EP. 21MEN/2004 tentang Sistent

Pengawasan dan Pengendalian Mutu Hasi Perikanan untuk Pasar Uni Eropa




BSN)

Penulisan besaran dan satuan yang umumnya banyak

dipakai:

BSN)

1. Satuan ukuran ditulis sesuai dengan Satuan International (SI)
dengan simbol yang sesuai dan memperhatikan besar-

kecilnya. Contoh:

Meter (M) ditulis meter (m), gram bisa ditulis g bukan gr.
Derajat ditulis dengan simbol degree (°) bukan “0 atau o”

dengan superscript

Untuk penulisan standar ukuran harus konsisten

2. Untuk penulisan rumus atau formula menggunakan equation

editor

3. Singkatan ppm(fraksi mq’%sa) ditulis dengan 106

4. Jangan campurkan informasi dengan simbol satuan. Contoh
isi air adalah 20 ml/kg dan bukan 20 ml H,0/kg atau 20 ml

air/kg

5. Gunakan istilah singkatan dengan satuan yang dibakukan
misalnya min (minute), cm3 bukan ditulis cc

6. Penulisan selang/batas dengan satuan.
Misal 23 °C % 2 °C bukan 23 * 2°C,
10 mm = 12 mm bukan 10-12 mm

Penulisan rumus/persamaan dengan equation

Klik Tools pada bagian atas windows, customize - muncul kotak dialog
klik Command->Insert cari equation editor dan muncul tampilan sbb:

Jika belum muncul icon equation bisa menggunakan langkah sbb: T

8 SNI 07-7706-2006 - Microsat Word

DSdan SR |V
Frd - Son- |8
=

A Wormal il -
T
e

denf

Gmy

& Pel

) tang

He Edk Vew Iset Fomat | Tods | Tobe Window Hep  AdvbePDF  AcrobakComments

Speling and Grammar. .. FIE=@ BT v -
Lenguage B

ord Courk...
AugoSummarize.

Speech

kst
Compare and Merge Documerts...

Track Changes

Protest Document...
Opine Collaboration v
= § (moimtjam)
Letters and Maings v

Touks orthe Web...

Heco v

umikan informasi setagal berih

) Kador i (%) contoh u]l pada saat pengujian.
&) hasi penguiian

n pengertia
adalah rat

pran
asil uji Q
T panel,

3l pengujia

air (%) con
iengujian.

To add a command to & toalbar: select a category and drag the:
command out of this dialog box to a toolbar.
Categories:

Commands:

Selected command:

Description

i chat [

V@ EmetionEdio) |
1

—
[ Voice Comment

% Pen Comment =~

@ Savein: [hormal

v Keyboard... Close
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Penulisan rumus/persamaan dengan equation (lanjutan)

R

n pengertig
adalah rat
ran

asil uji dari
T panel;

il pengujia

air (%) can
iengujian.

@ Save in: |Mormal *| Keyboard...

BSN)

"°'"""“'"5"""""‘9"0"

Toolpars  Commands l Cipions ]

To add a command to a toolbar: select a category and drag the
command out of this dialog box ko a toolbar.

Cateqories: Caommands:
m Chart j
4‘{ Wordart,,
|ﬁ Equation Editar |
=) Vaice Comment =
%, Pen Comment j

Selected command:

Description | |

| Close |

e E g

B b Gl Gfees Moy e Ve

ITLE
it Oat Hperink Soolma

Klik equation editor
drag dan tahan
kemudian letakan icon
pada bar windows

Equation untuk Word 2007

it
Saits
kmdG

Pilih Insert >
Equation
Kemudian Pilih
rumusan
| penulisan yang

sesuai
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Firs ShavigMatp - Shows D B D - D - 3- D@
A Normel + 2, + Arid -u - B I ESE

Icon telah muncul

L

]

Keputusan Menter Kelautan
Persyaratan dan Tata Cara Per|

a

Pengavwasan dan Pengendalian| Categories:

Keputusan Menten Kelautan g - S
Sistem Manajemen Mutu Terpa

Republik Indonesia. To add a command to & toobar: select a categery and drag the
Keputusan Menteri Kelautan da] command out of this dislog bo to a toolber,

o

Keputusan  Direldur  Jende
No.03725/BISK/VINES tanggal
dalam Makanan dan No 037]
Maksimum Cemaran Mikraba d

Tookars  Gommands | gpiiens |
Conmangs:
W chat = |
Al werdt..
& equation Edeor
. B2 viica Commerr -
Web . Pen Commen: =l
ora
3| swveim froma =] _tevvomd.. Tose

ma=cy

* Penulisan rumus
Contoh:

Rumus kecepatan
V=s/t

Keterangan:

s adalah jarak tempuh
t adalah waktu tempuh

—
Komite Akreditasi Nasional

« Penulisan rumus
Contoh:Rumus kecepatan

v=2
t

Keterangan:
s adalah jarak tempuh
t adalah waktu tempuh
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Contoh pemakaian simbol
ingin digunakan.

(degree sign)

6 - Hicrasoft Word

Fe Gt Wou | imot |Fgmet ok Tghe rndow bep Adherof Avchet ommerts

ag- - Fel ) < AFOE (@& T @ o -
Poge bumbers..

Feferes '

Bian
rata-rats ilai analisis gas (mgirem).
[ ,

£ Digam..
B 1o
i
Chect..
Sodmar. i
® ook Gk Jjan,
B} kadar ar (%] cortoh ujl pada sant penguijian;
B} hasi penguiian

Hari analis harus mencantumksn informasi sebagai berikus:

g

| et s ~
IGEEERE 9=--®Q®

EIRHEENEREEREEEn
KA AAECEEEET T 1D
76[0/8/5/8]x [20[0[0[0[¥ [P 82,

() VI#elel¥elom s 2] ]

[EEE wmirmlﬁ

[ ] o

) b v { ] caton o st pengan
&) hasl pengujar

g b

Pada gambar ini penggunaan symbol derajat

klik insert - symbol - pilih symbol yang

[Fh———
[T

= a(mz 4|

SOCEALT@E >-L-A-S7FE0F.

Duaw e [; mgashapss -

Track Change

* Mengedit (menambah, men-delete) kata atau kalimat

=l [SNI0T-7206-2006 - Microsoft Word

File Edit Wew Insert Format Tools Table ‘Window Help Adobe PDF  Acrobat Comments T
—~ o @
ERHESn SEY =N @ FOE =S8 T & we - @,

Final Showing Markup ~ Show > & &3 &p - A ~

A Mormal - Arial -1 - B 7 o

s B E RIS - B E A R T IO R BE S - BRSSP B Lz 3040008

'4‘|-3‘|-2-\‘1-|‘§-|a1'

fh) Tambahkan 10 ml asetil aseton dan 10 ml amonium asetat, erlenmeyer ditutup dar‘s
i hangatkan dalarm water bath pada suhu 40°C selama 15 menit
£) Dinginkan hingga suhu ruang, simpan dalam ruang gelap dan ukur absorbansi cl:mtmh
i dengan alat spektrofotometer pada panjang gelombang 412 nm
d)  Pengujian dilakukan duplo dengan menggunakan spesimen yang berbeda. Jika terjad\
i perbedaan nilai individu dari masing-masing ekstraksi lebih dari 0.5 mo/m? jam maka

harus dilakukan pengujian yvang ketiga

07/05/2018
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BSN)
TOC (Table of Content)
membuat daftar isi secara otomatis

1. Klik Format = Style & Formating

2. Klik New Style untuk membuat kategori dan ketik Name: daftar
dengan menyorot bagian yang akan diinput pada daftar isi

3. Sorot daftar isi lalu klik daftar
Prakata klik daftar
Pendahuluan klik daftar
Lampiran klik daftar

4. Untuk pengelompokan selanjutnya pasal, gambar dan tabel
ulangi langkah no. 2 dan 3 (kategori berbeda)
Kategori pasal contohnya ruang lingkup, istilah definisi, syarat
mutu klik pasal,
Gambar klik gambar
tabel-> tabel

F 10 L 12083 A |5 | AT = | @ + Styles and Formatti = x
Formatting of selected text

J 2d, Hanging: 0.75 cm,
Daftar 151
Select Al

Pick formatting to apply

Clear Formatting ﬂ

Properties

Hame: [daftar gt
Style type: [Paragraph -]
Style hased on: Er 16 pt, Bold
Style for Folloveing paragraph: ’—;I Arial

Formatting
Arial ~ 1z - B 7 U A - Arial, 11 pt
=sE==|[= =12 t=|«= = Arial, 11 pt, Black

al, 11 pt, Black, Cente
Arial, 11 pt, Black, Ju
Arial, 11 pt, Bold

Heading 3 + Indonesian, Indent: Hanging: 0.75 cm, Centered, Line Arial, 11 pt, Bold, B _

spacing! single, Space Bsfare: 0pt

wom|e

I &dd ko template I Auromaticalty update Show: |Avallable Formatting |+
ST = T S

10
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Formatting of selected text

L e ]

Select Al

Hew Style

Pick farmatting to apply

Empha

Foater 1

Header L]
Heading 1 ﬂJ

ng 1+ 14 pt, No
31+ Arial Narro
Heading 1 + Left,

Heading 2 ﬂﬂ

e om|e

Y KAN

Komite Akreditasi Nasional

Formatting of selected text

Arial, 11 old

Bentuk baku konstruksi j

Rewsiye = AR

Froperties
Name:

Style type:

Style based on:

Standar ini menetapkan batasan ukuran]  Styls for following paragraph:
nsang dasar  monofilamen.  Standa

engoperasiannya

Formatting

Paragraph -

1l Mormal hd

2 Istilah dan definisi

2.1

aring insang
alat penangkap ikan berbentuk empat peg
esar dan dilengkapi dengan pelampung

anpa ris bawah untuk menghadang arah
aring atau terpuntal pada bagian tubuh jal

22
tali pelampung (floaf line - fi)
seutas tali yang dipergunakan untuk mene|

[ add to template

Format =

Normal + Font: (Default) Arial, 11 pt, Bold, Swedish (Sweden)

[ Automatically update

7

2

Select Al | [ Hew Style

Pick formatting to apply

Clear Formatting

11 pt
11 pt, Bold
Arial
Arial, 11 pt

Arial, 11 pt, Before

Arial, 11 pt, Bold, J1

ntered, Line spacing

Arial, 11 pt, Beld

=

Show: | Available Formatting

-

VY KAN

Komite Akreditas Nasional
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BSN)
Setelah mengelompokkan kategori baik itu daftar, pasal, klik pointer pada

kolom Daftar isi klik Insert > Reference > Index and Tables, dengan
tampilan sebagai berikut:

Daftar isi
N
Index and Tables xR
Index | Table of Contents | Table of Eigures | Table of acthorties |
Prink Prexiew
ATSOtle .o 2| 2] TePEE @ Indented ¢ Rumrin
Asteroid belt............... See Jupiter Calumns: > =
Atmosphere
Earth Language: Indonesian -
exosphere.........n
ionosphere 3 v|
Tab leader: |....... -
Formats:  |From template +
Markeniry... | Adtodark., | modfy.. |

Komite Akreditasi Nasional

BSN)
Pada Index and table klik Table of content, klik Options

Daftar isi

=

Index and Tables ) ) R

Index. | Table of Corkarks || Table of Figures | Table of Atheriies |

Prink Preview Web Preview

Heading 11 || [Headng 1 ﬂ
Heading 2 3 Hea 2
Heading 3.3 Hea 3

-

[¥ Show page numbers [¥ Use hyperlinks instead of page numbers
[¥ Right align page numbers

Tableader: [....... =

General

Formats:  |Fromtemplate | Showlevels: [3 =
Show Outlining Toolbar Options... Modify...

.

Komite Akreditas Nasional
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Selanjutnya tampilan

Table of Contents Options, 3 R sebagai berikut:

Build table of contents from: Ket| k 1 pad a TOC Ievel
¥ Styles 1 .
vl o T0C evel pada kategori daftar
Ry U T - dan pasal. Kemudian
< daftar 1 . .
Footer il pilihan pada heading
Hj 1,2 dan 3 di-delete lalu
Heading 1 .
Heairg? ] klik ok
-
[~ Table entry fields
Reset QK Cancel |

[ ]
M)Akan muncul tampilan sebagai berikut dengan
ketentuan :

Format - Paragraph: before: O pt dan after: 6 pt

Daftar isi

Daftar isi . . . . [
Prakata . . . . i

Pendahuluan ...

1 Ruang lingkup

2 Istilah dan definisi

3 Simbol dan singkatan
g KIasifikasi. oo

2 Sketsa dan bentuk baku konstruksi ..o e
B Teknik PRADOREIESIAN ..ot oo e et e e e
LATTIIIEN By oo oot et et et et e et et

[ AT SN U ST 6 S e B S S

Bibliografi

13
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Daftar isi

Daftar isi
Prakata

Pendahuluan

Istilah dan definisi............

FUANG TG oo

1
2
3 Simbol dan singkatan ...
4 Klasifikasi.....cccocoo
2
3]

Sketsa dan bentuk baku konstruksi ...

Teknik PENGOREASIAN .. oo
LAMIPINAN A e
Bibliagrafi

Baste
Update Field
Edit Field, .,

Toggle Field Codes

Eont...

Paragraph...

Bullets and Numbering. ..

FL IR SR Y LY

word is updating the kable of contents. Select one
of the following options:

" Update entire table

o1 e | Jika ada perubahan pada daftar isi

(penambahan,pergantian)

klik=> update Table of Content

S
)
l T bome wet Pl | e | Moims  feew iew

.j 3 anage Sources } 2 Inser Table of Fgures } 3 insetindex Q# SinserTabe of Authores
b ¥ Update ndex ¥ shle

=4 Quewm - = e : ”
et vark etk
Cigion 1BRIOGRPRY ™ (apion ") Crossaeference £ty Cition
Table of Cantrts Femtes | Cooions i Bbingeapy Gaptions indes Taleof ot
Thmbeals  + X |0} [ et lew eimFomating 27 W e =T
| Homal | 2
Nonbered, A, 110t T
3 || Mmbered, Arid, 1102, Tl
K Nbeed, i, 115 Lo
l Outioe usbese, i3, 11
Outie usbere, A, 11
Outie uabere, A, 11
‘ Fageluber a
jsasi =t 1 M
I st T
Sfe2 1
‘Serp Tex Ssnse Tt Sere T Sempl Tex Serpie Tex Sarpie Tex Sange et e T
S Tec Sens Tet Serpe Tee Senpe Tee Serpe Tee Sempe Tox Sy et St g
‘Sample Text Sampe Text Ssmple Text Sample Text Sampie Text Sevple Text Sanple Taxt s g
B T
|| w7 1l
| IET L
1 Jstfed Thsps 3hid il
1om, 8t + 1.6, Lt b, St Qi St Bese o ol || Toc 144k 6t =
jaddnoukstieist [ ivonaicly it
® riyintisconmet () New dramensbsedon s epaie
L @a |

Pilih

Home > Style 2>
new style

Isi kolom Name

Klik Ok

14



BSN)
Kemudian sorot seluruh Judul halaman, judul pasal dan judul
subpasal dengan membuat direktori baru sebagai new style.

=/ Home et Pogelmosd | Releences | Malings  Reiew  View

=% Deaddlet- Zinsert Endnote 3 Manage Sources 3 3 Incet Table of Figures 2 InsertIngex a‘ ‘Zinsert Table of Authosities
= HupgateTable A% Hext Fontnate - G styte: P M Update Table 3 Update Inde 3 Update Table
Table of Insert Insert Insert Mark Mark
| Contents ~ Footnote = Show Notes Gtabon - & BBHOgERRY ™ | Caption |4 Cross-reference Entry Cation Styles vx
Table of Contents - = Citations & Bibliography Captions 2 Table of Authorities =y 'l i
B T R R R R S RN X X SR T TS SR SRRy SR RN ¥
Hezder T
ey 1 ¥
ez 2 4
Headng 3 T
- Heading 3+ Arcl, B0, LeF
Daftarisi Feadng 4 ¥
Headng 4 + Aral, Bod
Headng8 T
Heading T
Dafter s Headng 9 + Tk, Lef: 4,
Prakata — al
1 Ruang lingkup. Tialc, Rased by 3pt =
2 Acuan nomatif i 7|
. Justfied
3 Istilah dan definisi e 6ot
4 cara Justfed, Before: 6t
5 Justfed, Left 9,011 =
6 Peringatan D] shom Preview
T Seleksi panelis. ]
8 Pelatihan paneii BB oo
9 Seleksi dan kualifikasi model bau tak sedap.
10 Prosedur 7
11 F i 8

VKAN

Komite Akreditas Nasional

98 ATMELSE 8 ot Mok M ok e x
bm bt Pplnt | lmew ens e e @
P agmm_ j' T P ———
e N Qwe - = fueme 1 Jpmns S s
et ot ezt Vet at.
(ot Funiz ST G PIORY (i 0wy feris

= ot iy Gpios s Tk kit

Pilih Reference - table

contents

B

e ——

ko i 4 Ragmnca 3
B ——

| e — 3

3 It st B R §

5 T Sesigacks 3

 tnsetcses] :

5

7

of contents = insert table of

07/05/2018
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e bt Rl | Ao | MGbm o Ven °

D Brdadledr g i = kg sures thmmhlfﬁmm Y metinder 2 Sy Tl of Afcies

= Hpatse it Forage - = Gaem - = e T Suprinin E
Tt kst et bt Yk Wit
Carens” faomte = TN oo HERIGEIN T oy SCreseernce sy =)
Tt Corets ot G oot as S )
Tatleof (ot )
| xEl | SRRy T
d x| Tt s TeafFgres | e orutoies
il ey
[ - - & [ ———
dater 32 | | e —

Beadna]

10 Prosedur.
11 Presentasi sampel 8
2F seta 9

i ial wajt).
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1. Setelah muncul
Bar Table of
Contents Pilih Table
of Contents >
Options

2. Pada Menu TOC
Options, Klik
direktori-direktori
yang digunakan
sebagai Daftar Isi
dengan angka 1

3. Pada kolom
Heading 1,2 dan 3
dikosongkan

TERIMA KASIH
THANK YOU

BSN)

BADAN STANDARDISASI NASIONAL

vV KAN

==
Komite Akreditasi Nasional

Members of Members of
. S
i - L, FRe TPAC
www.bsn.go.id www.kan.or.id
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